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Support. 
(1) Technical support, for technical support for all aspects of SAND and SCALE please email a 

marked up copy of the calculations in question to Dr Ian Brown ian@fitzroy.com. 

 

(2) Accounts, if you have changed address or if there is a new contact person, please email: 

Jeanette Brown, jeanette@fitzroy.com or post to Lark Lodge, Fornham St Martin, Bury St Edmunds, 

Suffolk IP31 1SR. 

 

Eurocodes. 
All proformas now show full calculations to the Eurocodes or full calculations to the British Standards, 

or are analytical and applicable to both codes. 

 

Windows 10. 
All programs in the SAND and SCALE suites are fully supported, tested and operational on all 32-bit 

and 64-bit desktop/laptop versions of Windows 10, Windows 8.1, Windows 8, Windows 7, 

Windows  Vista and Windows XP Service Pack 3. 

 

Main changes to SCALE program in 2020 (Latest version is 5.85). 
The main items outlined in the last newsletter as plans for 2020 have been completed, namely: 

 The SCALE window can now be resized on the fly, without having to close and re-open SCALE. 

Simply click and drag on the edges or corners of the SCALE window, the window will dynamically 

resize to display the largest text size that fits within the dragged frame, and the frame will snap 

back to fit that text size when the mouse button is released. You can also select the menu options 

View->Decrease Window Size and View->Increase Window Size. 

 Combined the TAPE editor so it appears in the resizable SCALE window. For this update, TAPE 

appears for Option 15 for calcs with LUCID and SPADE diagrams, clicking on "Edit" will launch 

TAPE to edit the diagram. A future update will link TAPE to appear for any diagram on any results 

page. 

 Extended the parametric checking to nearly all SCALE and NL-STRESS proformas. 

 Added feature to import pictures for personalised header logos to SCALE 5, (select option 18). 

 Added ctrl+ shortcut keys to all bottom buttons, for easier keyboard navigation: The relevant letter 

is highlighted in red, e.g. Back is ctrl+b, Edit is ctrl+e. Some buttons renamed to avoid clashes: 

e.g. Continue=>Next and Regular/Condensed/Summary=>Output, as ctrl+c is copy. All button 

functionality remains unchanged. 

 Clicking on "Restart" now comes back to the "Proforma Number screen", where a different 

proforma can be selected bypassing the front menu.  
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Installation. 

As for the 2020 update, the 2021 update installs a desktop shortcut for it named “SCALE 5” (to program 

scale.exe), for both SAND and SCALE licences. 

 

As SCALE now includes all the NL-STRESS features that were previously only included in the SAND 

suite, there is no longer a separate front screen for SAND. 

 

SCALE version 5 retains the familiar scale ruler icon with a red stripe. The icon for SCALE version 4 

is the same scale ruler but with a blue stripe to differentiate between the old and new versions. 

 

SAND and SCALE version 4 are included in the installation for users who are familiar with their 

interfaces. Any existing shortcuts you have to them remain unchanged, shortcuts to the previous 

versions can be created on new computers to the programs scale32.exe and sand32.exe respectively. 

Each front screen now includes a new button which will launch SCALE version 5 if required. 

 

Downloading updates during 2021. 
Further updates in 2021 will be posted to the download website at the beginning of April, July and 

October, please visit the download website for the latest version of 2021.EXE. 

 

Plans for 2021. 
 There are still many intermediate files being saved to disk, these could be stored in memory to 

speed up the program. 

 Extend the integrated TAPE editor so it appears for any diagram on any results page. 

 Combine the GUI32 data editor so it appears in a resizable SCALE window. 

 Update SCP for printing directly from SCALE 5 rather than the current printing of pdf files. 

 Add an NL-STRESS portal frame generator, with integrated wind and snow load generation. 

 

Please send any feedback, or feature requests, to ian@fitzroy.com  

 

SCALE available on the Apple App Store. 
SCALE version 5 is available on the Apple App Store. Monthly and annual in-app renewable 

subscription options are available. The SCALE app runs on all iPads with iOS 9.3 and above, i.e. on 

every iPad except the iPad 1 from 2010. The SCALE app includes the full versions of SCALE, LUCID, 

SPADE, NL-STRESS, NL-VIEW, NL-PLOT, and SCP (for creating pdfs). Click on the link on the 

fitzroy.com website, or search for “SCALE Structural Calculations” on the App Store. 

 

Changes to SCALE in 2020. 
 Bottom buttons now drawn in Windows 10 style for all versions of Windows. 

 Added bitmaps for the plus and minus icons on the main menu, so they scale correctly with the 

window size. 

 Changed Help Manual viewer from a pdf viewer to one derived from SCALE, for reliability and 

better future integration. The scale.pdf help manual is still fully updated. 

 Added sub-section destinations and links for Help Manual Chapter 7: NL-STRESS reference. 

 Fixed squared sign on LUCID/SPADE previews. 

 Calcs preview, up+down arrow keys now scroll display up and down by a few lines. 

 For new installations, tooltips for proforma menu is now off by default, turn on with menu option 

View->Show Tooltips for List of Proformas. 
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 Added display of member loads for plastic and sway analyses in NL-VIEW 3D visualisation. 

 Added DXF export to LUCID and SPADE, right click on the diagram and select Save as DXF.  

 The DXF files are A4 drawings, to scale, in mm, for easy measuring and editing.  

 The DXF files have six pens on separate layers for easy customisation.  

 Fixed display of self weights in NL-VIEW 3D visualisation. 

 Fixed pdf page layouts for non-scale output after saving to docx. 

 Fixed lines containing <H1> in non-SCALE output docx files to not be emboldened. 

 All edit screens now have a 'Continue' to accept changes and a 'Back' to abandon changes. 

 Fixed bug when you try to copy headings from the current file to itself.  

 Fixed bug with docx creation when no images or graphics characters required. 

 Fixed going to File selector from NL-STRESS benchmark screen. 

 Fix for hang when switching to brand new stack file. 

 Fix for getting stuck in EDIT boxes containing strings for new stack files if default values not 

initially chosen. 

 Fix for square root sign occasionally being omitted from pdf output. 

 Fix for resizing File selection window. 

 Fixed issues with printing at the end of NL-STRESS and NL-PLOT runs. 

 Fix for switching between Regular/Condensed/Summary calculations. 

 Fix for problem with stack file containing more than 50 strings. 

 Fix for EDIT field not displaying string label when string is initially blank. 

 Fixes associated with "Proforma Number screen" when changing headings file, and showing 

proforma structure. 

 Fix for LUCID and SPADE when Summary mode is selected. 

 Added a new "Proforma Number screen" straight after any proforma is chosen in the menu. 

 This screen gives the proforma description, and a text field to amend the proforma number if 

required. 

 The "Page Headings File" screen now has its own separate screen, without reference to the 

proforma. 

 Fix for /p option showing proforma structure. 

 Fix for option 1, BM&SF diagrams for NL-STRESS structure, now runs correctly when selected 

by the user. 

 Amended file now displayed and editable after FILE option. 

 Fix for footer line for amended calcs display with plots present. 

 To speed up output and reduce clashes with open files SCALE now saves the pdf before printing, 

rather than automatically. 

 Fix for GUI running with different working and installation directories. 

 Fixed display of calcs when File->convert... menu options are used. 

 For pdf and docx creation of non-SCALE files, fixed last line being replaced by footer. 

 <H1> heading command now ignored for pdf and docx generation from non-SCALE files. 

 Proforma selection window now remembers last selected, expanding/collapsing bugs fixed. 

 When NL-STRESS does not run, now goes to display of .res file if created. 
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 Fixed longstanding NL-STRESS bug - can now run combination load cases for all PRINT options. 

 New menu option: File->convert file to Word (docx)... 

 Re-instated menu option: File->convert file to pdf... Now works correctly. 

 Word file for non-SCALE output is now plain text with blank headers/footers. 

 Added more rigorous checks for when output files are opened elsewhere. 

 Added 'View Structure' back to GUI Geometry menu. 

 

User’s manuals. 
The User’s Manuals for SCALE, LUCID, SPADE, NL-STRESS, NL-VIEW, NL-PLOT are contained 

in the file scale.pdf, which can be easily launched from the menu option Help->Help. 

 

Parametric checking of SCALE proformas. 
The parametric checking of proformas, to detect where users may experience problems and fix them, 

has been extended further in 2020 with 166 new .prm files and 18 modified .prm files being developed. 

 

New proformas. 
sc018  new proforma to add a company logo to each pdf calculation page. 
sc048  new proforma to print out a description of every SCALE, LUCID, 

SPADE, and NL-STRESS proforma. 

 

Changes to SCALE proformas. 
In addition to the proformas detailed above, we have made amendments to 698 proformas, the main 

changes are listed below: 
 
bricom  added missing percentage (%) to variable pcr, enhanced STRESS and 

STRess routines. 
ec5r2  added routine eu822d. 
ec5r3  added ec823d routine, replaced (k) with (m) for linear 

interpolation case only. 
lu002  added more text. 
ec4com  added NWC and LWC to summary of COMMON routine. 
lu110,120,130  added units and more text. 
lu210  made some lines hidden in b103 routine, added more text. 
lu220  added more text and missing units, added missing EDIT. 
popup  updated ASSBRI routine. 
sc015  extended to allow displaying, editing, appending, and saving to pdf 

and Word, of any text file used by SCALE. 
sc052  added opt=4 and scenario IF 12*m*n<s for opt=3. 
sc072  replaced dmin with dmax, added scenarios IF nbars=1 and IF ncbar=1. 
sc073,074,075  removed EDIT before $101 to suit PRM file, replaced dmin 

with dmax. 
sc080  removed EDIT before $101 to suit PRM file, maximum effective depth 

is now displayed as dmax and not dmin. 
sc081,082  removed EDIT before $101 to suit PRM file, maximum effective 

depth is now displayed as dmax and not dmin. 
sc086  removed EDIT before $101 to suit PRM file. 
sc100,102  replaced dmin with dmax. 
sc103,105  added option to select code=1 or code=2, added popup.pro, fck 

is now specified when code=2, added table 3.2 before START and 
several "." at start of lines. 

sc106  replaced dmin with dmax, added scenarios IF cont=1, IF cont=0 and 
set sym=1 before command START, removed flange=1 before START to 
suit PRM file, added default values for fyk and sym before START. 
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sc107  replaced dmin with dmax, added scenarios IF cont=1, IF cont=0 and 
set sym=1 before command START, removed flange=1 before START to 
suit PRM file, added Ex3 & Ex4, added default values for fyk and 
sym before START, removed flange=0 before +b=bw. 

sc110  updated scenario IF scr<2*ds to IF scr<1.5*ds for punching shear 
check. 

sc122  added Ex6 & missing EDIT's, replaced Asv with area where 
appropriate, made str hidden where appropriate, enhanced DESIGN 
SUMMARY. 

sc125  added missing STOP command, repositioned text above EDIT, added 
date on line 1. 

sc127  enhanced diagrams. 
sc130  removed reference to TD 19/85 and BD 37/01, added reference to BS 

5400-2:2006. 
sc148  added missing percentage signs to parameter pcr. 
sc149  added popup routine, items 1.41 and 1.42 now display correctly. 
sc153  defined gamc and gams before START command, corrected chkrng for 

ans4. 
sc154,156,158  added gms and gmc before the START command. 
sc165  replaced <H> with <H1>. 
sc189  added routine SPConc for standardized prescribed concretes, added 

more text. 
sc190  added parameter "bartyp" to suit PRM file, added several "." at 

start of lines. 
sc191  added parameter "bartyp" to suit PRM file. 
sc193,194,195  updated LOADING routine. 
sc250-259  Fixed a fast forward issue. 
sc256  replaced BS 449:1990 with BS449. 
sc274  added double shear types and option to use more than three bolts in 

one line when stype=3, added eu823d and ec823d, added Ex's 8-11, gp 
is no longer defined IF type=3, added type=4, 5 & 6, renamed euspbm 
with spbm1, added spbm2, modified 'he' default values. 

sc350  L1=1.83 is now only set as an example default value, replaced sp 
with L1, added Stainless Steel CHS handrails and balustrades as 
another option (option=2), added parameters h1, h2 & h3, enhanced 
diagrams. 

SC360  removed surplus chkrng for fy, added missing chkrng default values 
for 'e' and 'eo' before START command. 

sc361  enhanced screen display for selecting ans4. 
sc362  renamed ans1 with ss for steel standard only, added ss default 

values to example. 
sc364  revised default values for 'a' and 'tp'. 
sc365  added default values for stiffener thickness (ts) to example, 

variable name ts is now user defined. 
sc368  updated STRESS routine. 
sc371  added STRweb, revised default values for syw & fyw, added Sgrade 

for web, added default values for wGrade, enhanced diagrams. 
sc372  added chkrng to beta, sigf & tf parameters are now defined once 

only. 
sc373  corrected expressions for leb, added « to expressions, enhanced 

text for, ke, revised default values for d1 & d2, added more screen 
display diagrams, set k1=1 when ans8=1, reinstated square root 
symbol to expressions, replaced ans3=0 with ans3=2, replaced ans8=0 
with ans8=2, replaced ans14=0 with ans14=2. 

sc374  added ansc before START command, added lamLT=0 in routine LTBuck 
when Ltb=1, replaced EDIT /W 6 with EDIT /W 5, added partial 
factors before START command, added missing fyd & Mmax, an3 
replaced with ans3. 

sc382  added Ex5, largest panel length considered when ans2=0. 
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sc412  when zero length between restraints is specified program now sets 
Ly=1 mm (BS option) and Lz=0.001 m (EC option). 

sc422  replaced plate with end plate, limit for plate thickness is now 
shown in output under the heading 'Triangular limit'. 

sc423,425,427,487,494  limit for plate thickness is now shown in output 
under the heading 'Triangular limit', added WARNING when flush end 
plate is not used, added more text. 

sc424  limit for plate thickness is now shown in output, replaced 'Not 
applicable' with '[Not applicable', replaced plate with end plate, 
defined pitch of tension bolts when trow=2 for both BS&EC options. 

sc460  reference to joint 2 & 7 updated to joint 7 & 29. 
sc486  limit for plate thickness is now shown in output under the heading 

'Triangular limit', replaced plate with end plate, updated SUMMARY 
diagram, added WARNING when flush end plate is not used. 

sc521  Fixed a fast forward issue. 
sc538  updated links section and added IF e>0.5*t scenario, added further 

background notes, added IF ex>0.5*t/1000 scenario, added more text 
when links are not required. 

sc543  updated to Departmental Standard CS 454. 
sc547  added reference to Clause 7.13 (restrictions to the use of the MEXE 

method), replaced UD load with UDL. 
sc550  enhanced diagrams, fixed a fast forward issue. 
sc554  replaced BS5628:Part 1:1992 with BS5628:Part 1:2005. 
sc643  replaced Ned,Mzed & Myed with NEd,MzEd & MyEd, removed references 

to yy/zz, replaced Mnyrd, Mnzrd, Mplyrd, Mplzrd, Nplrd and Mplrd 
with MnyRd, MnzRd, MplyRd, MplzRd, NplRd, MplRd, replaced xx axis 
and zz axis with major axis and minor axis, replaced Sy, Sz, Sry 
and Srz with Wply, Wplz, Wrply and Wrplz, modified screen 
textrelating to parameter type, repositioned stg, set ans=1 before 
START, modified example default values, replaced Syz with Wply for 
CHS's, program now stops when type=0 is selected. 

sc659  replaced INFL1 with HINFL1 for option 8. 
sc674  added further text and pic1, made several enhancements, ans=4 is 

now ans=1, enhanced diagrams, replaced é with „ and added further 
EDIT’s. 

sc678  replaced Option (1 - 3) with Option (1 - 2). 
sc679  added more screen text relating to units. 
sc684  redefined ans & ans1, replaced units kNm with kNm/r for Torsion 

spring and moment spring, replaced reference to 914 with option 39. 
sc687  corrected question prompt for parameter "ans". 
sc702  added net pressure sign convention. 
sc720  added scenario IF l(i)=0 OR a(i)=0 to suit PRM file. 
sc731  added several "." at start of lines required for SUMMARY. 
sc761  reference to option 561 replaced with option 921. 
sc775  updated sfound routine, added more scenarios value for 'strip' is 

now selected by the program. 
sc801  enhanced diagrams, second floor diagrams now show joint 34 

correctly. 
sc803  global axes updated in all diagrams, added b1 & b6 parameters to 

member loads, added wd, updated LOADING section, revised text, made 
enhancements, added local direction where relevant. 

sc805,806,807,808  fixes for parametric data and comment lines. 
sc809  updated text, added scenario IF j+2*nv<3*nv GOTO 100 associated 

with JOINT COORDINATES. 
sc810,812  fixes for comment lines, enhanced diagrams. 
sc811  fixes for comment lines, updated proforma title to refer to 

temporary works column outriggers for bolted erection. 
sc850  added popup.pro, nm values always need to be specified. 
sc855  added popup.pro, updated chkrng for "ans", added missing "." at the 

start of lines. 
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sc857  enhanced diagrams, added pic1 to pic6, added joint numbers to 
diagrams and missing units. 

sc861  enhanced diagrams. 
sc863  added pic1. 
sc864,865  redefined 'pin' relating to internal members. 
sc866  redefined point loads W9, W10 and W11. 
sc867  replaced FINIsh with FINISH. 
sc872  added units for joint loads. 
sc873  removed 'axes', added code=2 before start, added missing % at 

start, of JOINT LOADS (line 1114), reinstated routine axes. 
sc874  made changes to accept nl>4 and adl=1, added more text and Ex3. 
sc876,885,889,925,980,981,982,984  fixes for parametric data. 
sc878  added missing units enhanced diagrams, changed default value for 

Young's modulus to 28E6 for Option=2 (as used in sc855.pro). 
sc882  renamed s with s1 and h with h6. 
sc883  renamed s with s1 w with w1and h with h1. 
sc884  added units for point loads and distances. 
sc890  fixes for parametric data, added WARNING when odd number of struts 

are not selected. 
sc891  added missing dimensions, Udl with UDL (text only). 
sc892  fixes for parametric data, removed 'nu' default value from Ex1, 

added NOTE. 
sc893  removed 'nu' default value from Ex1, added NOTE. 
sc894  fixes for parametric data and comment lines, added NOTE. 
sc895  fixes for parametric data, clarified dimension c. 
sc922  fixed error associated with ny=3 and ny=9, added Ex4 (ny=3) & Ex5 

(ny=9). 
sc940  enhanced diagrams, corrected displaced diagram text. 
sc941,942,943,944,945.946,947  enhanced diagrams. 
sc966  added more screen display text to diagrams. 
sc983  fixes for parametric data, updated example default value for 

Young's modulus. 
sc985,986,987  fixes for parametric data. 
sc8000  removed axes from data routine. 
sp005  updated $29 and $30. 
sp619  added DPC to sleeper walls, added reference to sleeper walls, 

enhanced diagrams and added pic1. 

 

Downloading updates during 2021. 
Further updates in 2021 will be posted to the download website at the beginning of April, July and 

October, please visit the download website for the latest version of 2021.EXE. 

 

Ian Brown 01/01/21 


